Purpose:

Audience:

Terminology:

Status:

Money Grows on Treeys, Inc.

StakeFlipper Operations Support Procedures
SharePoint Document Library

User Guide

Tim Gill

To describe how to use the SharePoint document library for StakeFlipper Operations
Support procedures, for both staff who contribute and edit documents and for staff who
just need to access & read documents.

Any staff in any StakeFlipper or related group at Money Grows on Trees, Inc. who writes
or edits documents, or just wants to find and use the documents, in the library.

document coordinator:

This is the staff member who administers the document library. Duties include such
tasks as creating new procedure document stubs from the template, maintaining
SharePoint library organization and custom views, defining SharePoint columns and
values, and helping to maintain terminological consistency.

This role is performed by me until I complete my assignment, when it will be passed to
another staff member.

Draft—it is in a good and nearly complete state but may be improved as usage dictates.
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If you are reading this document, you have found it in the StakeFlipper Operations Support document
library, which is part of the StakeFlipper SharePoint site—so you already know where this library is
located. This document aims to tell you everything you need to know about using this library.

Library Project & Origins

This library was done as part of work in 4Q2007 to implement some recommendations from the “Fixit-1T”
or “BounceBack” project. The work done to develop the library resulted in project documents for the effort
itself, which are themselves stored in the library (use this custom view to see only the library’s project
docs). These documents, especially the “priorities” spreadsheets, are a project management tool to guide
the setup—the definition of the Operations Support procedure documents done in those spreadsheets
govern what gets put in this library and are the source of the authoritative definition of the set of documents
to be done while this project is still ongoing.

Library Structure and Organization

There will be about 350 operational procedure and process documents in this library for North America
Operations when it is complete. All procedure documents are located in the top level of the library (there
are no folders for them—only a single folder for project documents for the project to setup this library), and
can be organized and found using the standard features of SharePoint for this purpose—columns and views.

Each document will be classified using a small set of attributes specific to this library, using the columns
feature in SharePoint. Some of these attributes are required, and limited to a controlled set of values, others
can be free text. Here are the 6 attributes created specifically for this library:

Possible values:
. Apps

Area Client Services
> relevant area of StakeFlipper operations NCC

infrastructure . Networks
. Servers
Possible values:
PType . RO routine procedure
> type of procedure . TS troubleshooting procedure
. RV recovery procedure
Author Possible values: _
> person assigned to write the document > one-word _text, naming the
author/writer/lead for the procedure
Due Date

Possible values:

> date manager has agreed to have draft
J d > any date up through late Feb 2008

ready for Sam Smith
Possible values:

. stub empty doc (except for title and
DoclID) ready to check out
. basic a draft, but needs more work
State . draft a decent draft
> the status of the draft of the document . ReviewDraft ready for review/approval

Once there are no documents with the stub value,
this column may be removed from the library, since
the built-in column Approval Status will have all
the information needed.

Keywords
> words to improve the chances of Possible values:
locating a document using a browser’s > upto 2 lines of any keyword text

Find command
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Document Identification

Document Titles

o Ifyou are accustomed to giving Word documents long filenames that basically provide the title of
the document, you need to change your habits for this library—in this procedure document library,
we make use of a document’s Title property.

o  The Title of a document is the main way by which it will be found in the library and is the proper
location for the descriptive information on the document and is displayed by default in
SharePoint—a document’s Title is one of SharePoint’s default columns, or attributes, for a
document. The Title is also one of the document’s Word properties; you can use
File > Properties in Word to change the value of this property, and it can be changed in
SharePoint as well—Word and SharePoint actually share the same data).

« You should also use the title from the Title attribute for the Procedure Name in the 2" line of the
document header table (from the standard library template for these documents); try to keep these
2 fields the same. When the document coordinator creates a stub for a new procedure document,
care is taken to get this Title attribute set correctly, and the same as the title in the header, so that
empty document can be found and checked out.

o Most titles will also have a prefix that helps identify a document as a member of a particular
series. When the needed procedures were identified early in this project, they were grouped into
categories (e.g., Argent alerts, database administration, customer reported problem). Using these
series names as a standard prefix for each series helps users find document quickly, as the eye will
see the grouping when lists of documents are sorted by title. For example, there are at least 6
procedures related to Argent alerts (Argent Alert: Memory/CPU Problems and Argent Alert: Disk
Space Problems).

« Note that the use of words troubleshoot and procedure in titles and lists of documents is usually
redundant and takes up “mental space”, and space on a SharePoint webpage, since all these
documents are procedures, and the procedure type of troubleshooting procedure (TS) appears
other places in a SharePoint view to identify the document. So | would usually omit these words
from document titles.

Document IDs

« Documents are also identified with a long, hyphenated DoclD, and this is used as the filename the
document is stored with in SharePoint. These DoclDs are created by the document coordinator,
and you should just use the filenames assigned to you. The document IDs are of the form TB-
NA-OP-TS-AP-nnn.doc, where the 2-letter codes are meant to provide some flexibility to
expand this scheme beyond StakeFlipper in North America.
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Version Control

o All documents in the library are maintained using version control in SharePoint. This provides
several advantages: a history of changes (with comments), access to older versions when needed,
and prevention of conflicting edits from 2 persons at the same time. For now, all versions are
minor versions and the version increment is 0.1.

« When documents are under version control, you need to check out a document to make changes,
and check in the document for other people to see your
changes. These options are available from the drop-
down menu in the Name column. (In some views,
there is a Type column that shows a Microsoft Word

icon, but this icon has no drop down menu and only lets you look at a document—you
do not get it checked out by clicking on this icon, just a read-only copy.)

In general, it’s a good idea not to have a document checked out for too long—especially if it is one
that other people will make changes to. So don’t keep documents checked out for days at a time.

o To check out a document, use one of two drop-down menu items in the Name column for the
document you want to edit:

1. Two steps: If you use the Check Out menu item, the file is
checked out but not opened in Word. A small green icon with
a down-right arrow is
added to the Word
icon in the Type
column for the file, if
that column is in your view—you can click on this icon to
open the checked out file in Word. If that icon is not there,
you can use the Edit in Microsoft Office Word menu item in
the Name column.

2. Onestep: Use the Edit in Microsoft Office Word menu
item; it will issue a pop-up to ask if you want to check it out;
if you reply OK, the document is checked out and appears
right away in Word for editing. When you save it and close it
in Word, the changed temporary copy is somewhere in
SharePoint temporary storage (not on your PC), but not
checked in until you use the Check In menu item (unless you have Office 2003, which is
more integrated with SharePoint—then there will be a prompt asking if you want to check it
in or keep it checked out).

o To check in your document, use the same menu in the Name column. The Check Out item will
be replaced by a Check In item when the document is in a checked out state.

Be sure to enter a short comment on every check in. This will help you and others to understand
what changes were made in a particular version—this can sometimes help when the history of the
evolution of a document is important.

« If you check a document out and then realize you do not have time to make the changes you
planned on, or you find you checked out the wrong document, you don’t have to check it in to
release the lock on the file. On the same drop-down menu on the Name column that you find the
menu item Check In, you will also find the choice Discard Check Out, which will unlock the
file and remove the version made available for editing. If you don’t know if you made changes to
the file, you can use the compare feature in Word to see what has changed (I don’t know of any
similar feature in Excel): use Tools - Track Changes - Compare Documents.

o Inthe future, we will tie an approval process to the promaotion of a file to a major version. The
implementation of this is being investigated.
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Writing and Editing Documents

Most staff will be using this Guide to the library to write and edit the procedure documents it contains. So
this section addresses topics of concern to authors of the procedures.

Structure of a Procedure Document

A common structure and format has been adopted for the procedures documents in the StakeFlipper
Operations Support procedure library, defined in a template file. Each document has 3 sections:
1. Procedure Information
This is a table giving identifying information about the procedure, an important part of putting the
procedure in the context of the organization.
2. Procedure Summary
This is a brief summary of what the procedure does.

3. Procedure Description
This is usually a numbered or bullet list, giving the complete procedure that the person using the
document should be following.

New Documents

When a new procedure document is begun, the document coordinator starts it from the current template
(see below for more information on the template). This beginning document, from which you begin you
writing of the procedure, is called a stub. Since all documents are maintained under version control, don’t
forget that you need to check out a document before you can edit it.

Writing Drafts & Updating Existing Documents

When the document coordinator makes a stub for you, they fill in only a few lines of the standard header
(the part giving Procedure Information) in the document: the Identifier line, the Procedure Name line,
the Region line, and the Owning Group line; when they do so, they change the font from the template
from italic and blue to regular. All the remaining lines (still in italic and blue), need to be filled in by you
to contain the proper information, and changed to a regular black font.

And to write your procedure, you use the 2 sections below the header, the Procedure Summary and the
Procedure Description.

Updating the “metadata” in your documents

SharePoint stores information about your document, generally called metadata; such metadata includes the
values for the various column values that SharePoint stores for each document, such as Title and Author.
You can update much of this data as well as the content of the document itself, but—just like when you
make changes to the document itself—you must have the document checked out.

As a habit, every time you edit a document, you should verify that this metadata is correct. Maybe the title
has changed a little (perhaps by the library coordinator to make titles sort properly into their series in views
sorted by title), maybe the procedure has been reassigned to another author, maybe the Due Date has been
delayed, maybe someone made a clerical mistake in setting the Area and PType fields.
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Title

Earlier in this Guide in the section on Document Identification, we discussed how the title of a document

is the most important piece of identifying information, and how SharePoint keeps the Title column it
maintains and displays in a view consistent with
the Title attribute in the Word file. This is useful,
but there is no automatic connection between this
title and the

Procedure
e line
in the

document’s header table. So you need to ensure that these 2 titles
are consistent.

The document coordinator makes these titles consistent when the

document is first created, but because of editing done in SharePoint to try to improve the prefixes in
document titles, sometimes you may find that the title in SharePoint is different than the title in the
Procedure Name ling; if this is the case, you should make the Procedure Name title the same as the one
in the Word file’s properties.

State, Author, Due Date

In addition to the Title, 3 column values (document attributes) might need to be updated when you update a
document. Such updates are done with the Edit Properties menu item from the drop-down Name menu in
SharePoint. Keep in mind that these updates, just like changes to the document itself, require the document
to be checked out:

State If you’ve just updated a stub document with your first draft, you need to change the
State column value from stub to draft (or ReviewDratft if it is ready for approval).

Author If the Author has changed, update this column value.
Due Date If the Due Date has changed, update this column value.

Here is what an Edit Properties window looks like:
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Document ID

Finally, the document ID might need to be fixed in 2 places when you update a document. These are fixed
in the document itself:

Document Occasionally, this document ID in the first line of the Procedure Information header might

Identifier differ from the filename used to store the document (seen in the Name column of a SharePoint
view). This usually happens because of a clerical error on the part of the document
coordinator. The 2 IDs should match, and the filename rules.

left page footer  Occasionally, the document ID in the left side of the page footer might differ from the filename
used to store the document (seen in the Name column of a SharePoint view). This usually
happens because of a clerical error on the part of the document coordinator. The 2 IDs should
match, and the filename rules.

Terminology and Appearance Standards
TBD.
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Approval Process

In February 2008, a few months after this document library was setup and when about half of its targeted
350 documents were in a draft form, an approval process and mechanism was put in place, using features of
SharePoint. This Guide was amended to reflect the changes, which were minimal:

«  When the approval process is turned on for the library, SharePoint automatically adds some new
columns to the library (e.g. Approval Status and Approver Comments) and some new items to
various menus (e.g. Publish a Major
Version and Approve/Reject). The
new columns were added to most
views.

«  With the new Approval Status column
SharePoint uses, our previous column
Status was renamed to State, and will only be of value while some documents are still in the
stub state (it will probably be removed from the library at that point). The default
Approval Status for a document is Draft, and the value and notion of ReviewDratft for the State
column will correspond to a value of Pending for the column Approval Status.

« Authors/contributors are responsible for requesting that a document of theirs be approved.

Approval Process for Authors

1. Proceed as usual with your authoring cycle: checking out the document to make changes, and
check it back in fairly often to show progress (and get the protection of system backups). While
this occurs, the version number is increment in tenths, from 0.1 to 0.2 to 0.3, etc.

2. When you believe your procedure is ready for approval, you need
to tell the system this (before we had the approval mechanism, you
would change the State column to ReviewDraft). To do this in
SharePoint, you select the Publish a Major Version item from the
drop-down menu on the Name column for the document. It
prompts you to append a comment to the current comment for the
current minor version. This step does not require that the
document be checked out from the library.

3. The previous step changes the value of the Approval Status
column from Draft to Pending. At this point, the manager must
approve the draft (managers have a view to look at which
documents are pending approval).

4. Keep checking your view to see if your document is approved or rejected. If approved, the
Approval Status column will have a value of Approved and if not, it will be Rejected.

5. If rejected, you must address the problems by making another minor version, which will be a
Draft version again, and then request approval again as in step 2. above.

If you have to come back in a few months and change the document to reflect changes to the procedure, the
new Draft version will have a number like 1.1 initially, and then the approval process could begin again.
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Approval Process for Managers (Approvers)

Initially, the approval of a document will be done by Sam Smith or Alan
Skamarak. The steps are as follows:

1.

To see which documents are awaiting approval, use the built-in view
from the View drop-down menu called Approve/reject Iltems. This will
show you a view with the documents grouped by their Approval Status.

For each document with a Pending status, read the document and decide
on whether you will approve it or not.

Use the Approve/reject menu item from the Name drop-down menu to
approve or reject
the draft. Note
that on the
screen that
appears, you must select the correct
button to approve or reject. You should
also enter a comment that the author will
see, especially for any rejected drafts.

4.  When you finish with one of the
Pending documents, your view will
automatically refresh and show one less
document that is in that state.

Miscellaneous

For the time being, be cautious if you put in hyperlinks, in your Word files, to other documents that reside
in the library. This requires embedding a URL to the target document in a hyperlink defined in the source
document (yours), and SharePoint has no way to keep the target URL constant if the library gets
reorganized. This means hyperlinks could break if your target document gets moved to another location in
SharePoint.

Document Template

The standard procedure template is maintained as the file 1-template.doc in the library.

The document coordinator is responsible for maintaining the template.

When a new document is begun, it should start from the current template, to maintain consistency.
(At this time, the feature in SharePoint to make this automatic does not work for us, probably
compatibility issues between Office 2000 and SharePoint Services 3.0).

The template will evolve a little overtime. If it has a new form when you start a new document,
you can use the new info (usually in header table in preface) to update your older docs. But don’t
worry about doing this.

SharePoint. IT-UserGuide.doc / p. 10 of 13 Draft /v0.23 8:11 PM on 4/7/2008



User Guide for Operations Support Procedures SharePoint Document Library

Finding Documents

One of the main reasons for using a document management system like SharePoint is to make it much
easier to find documents. You may want to find a document either to read & use it or to modify it, and
these 2 reasons for finding a document can alter how you go about finding it. SharePoint provides a couple
of features that make finding your document easier, in both cases.

Main SharePoint Features for Finding Documents

Although SharePoint allows documents to be categorized into folders, like a traditional file system, two of
its features, columns and views, provide a better mechanism for finding documents, and
we use them for this library:

o columns:
A column is an attribute of a document, such as its filename, title, author,
status, or modification time. Some columns are built-in to SharePoint and
others can be defined for a library; the StakeFlipper Operations Support
procedure library uses a combination of both. See the list of columns defined
for our library earlier in this Guide). Columns can be manipulated in any
view: the entire list of documents can be sorted on a column’s value, and a
subset of the list of documents can be displayed by selecting a single value of
the column; both these features are available from the drop-down menu of
each column, and can be pre-defined for a stored view.

e Vviews:

A view is a named configuration of a web page used to view the contents of a library, and the
configuration can determine if all or a subset of documents are shown,
how they are grouped or sorted in the window, which columns appear in
which order, etc. There is a default view as well as custom views, both
public and private. Since a view is referenced by its URL, hyperlinks to
show a view can be used in documents or e-mail messages, and the URLS
can also be bookmarked

When you first go to the library by browsing in SharePoint, or specify a URL that
does not include a view-specific suffix, SharePoint puts you into the default view.
All views can be accessed from the drop-down menu at the top right of the
SharePoint window that is already open to some view of the library. The default
view for this library (the first one in the menu) shows all custom columns and the
typical built-in columns from SharePoint, and is sorted by document title. But it is
not necessarily that useful, and typically shows too much information for most
users. Some of the custom views are more useful.

The larger screen shot below shows both of the above features in more detail. Both the Area and PType
columns (with the gray funnel symbol) are filtered to a single value (Servers and TS, respectively). And
the Author column is sorted (note the down arrow icon) in reverse order, so Weinstein appears first). This
example filtering reduced a list of 70 documents to these 6.
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Finding Documents to Read and Use

The best view when you simply want to find and read any document in the library is the just.findit
view. This has fewer columns visible, is sorted alphabetically by Title, and shows optional Keywords that
an author might have added to make it easier to find. You should make good use of the Edit = Find
capability of your browser (Firefox is better in this regard, if you have it, because of its option called

Start finding when you start typing).

Note that in this view there is no way to checkout a document for editing—if you are looking for a
document to read and use, you don’t need to edit it, so this information is not there, cluttering up things.

Finding Documents to Edit

I have defined a number of custom, public views for this library; all are available from the View menu at
the top right of any SharePoint page. The most helpful to authors and managers is probably the set of Area-
based views, liked just.NCC. These show only documents of a single StakeFlipper Area (areas that own
procedure documents), and group them by State and Author, to help authors and managers look at the
progress in the drafting of the procedures. So they are specifically organized to make it easier for authors.
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Personal Views to See Exactly What You Want

Any user can create a custom personal view to look at the documents in the library in a way that suits her.
They are easy to play with learn what is possible, if you have the time. Just use the Create View item
from the View drop-down menu.

The Search Box

The Search box at upper right of the SharePoint window is a full-text search, with no capability to limit the
search based on metadata. It also searches the entire library, even if your current view only displays a
subset of the documents in the library. So it is a fairly crude mechanism to find documents for this
particular library. A typical use for it, however, is to answer a question like “Which procedures refer to the
Cisco Router model 123?”; searching for those terms will likely produce search results with all the
documents you want.

In general, when looking for a specific document, it is better to use the Find command in your browser in
an appropriate view.
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